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About this Guide

The RocketRAID 1720 SATAII Host Adapter’s User’s Guide provides information

about the functions and capabilities of the host adapter, and instructions for

installing, configuring and maintaining RAID arrays hosted by the adapter.

Introducing the RocketRAID 1720 Host Adapter

The HighPoint RocketRAID 1720 is a 2-channel PCI to Serial ATA II RAID controller.

The RocketRAID 1720 solution is ideal for small business servers, NAS storage,

workgroup and web servers, back up, and security systems.

Product Features

• PCI 32bit@33/66 Mhz

• 2 SATA II 3Gb/s ports

• Up to 2 SATA II or SATA I Hard Drives

• Support RAID 0, 1, and JBOD

• Backward compatible with RocketRAID 1640 RAID arrays

• Native Command Queuing (NCQ)

• Online Capacity Expansion (OCE) and Online RAID Level Migration (ORLM)

• Staggered drive spin up

• Hard Disk (Activity / Failed) LED chassis function

• BIOS Booting (INT13) to RAID array

• Quick and Background initialization for instant RAID access

• Write through and write back cache for RAID arrays

• Hot swap support

• Online array roaming

• S.M.A.R.T array monitoring for hard drive status and reliability

• 64-bit LBA for RAID arrays greater than 2TB

• Low profile form factor for 1U chassis

• Web browser-base software (Web GUI)

• Command Line Interface (CLI)

• SMTP email notification for events and error reporting

• Remote array management through (Web GUI, RAID GUI and CLI)
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• Support Windows (XP, 2000, Server 2003, Vista), Linux and FreeBSD

• RoHS Compliant

Understanding RAID Concepts and Terminology

The following concepts and terminology is commonly used when describing the

functions of the RocketRAID 1720 Host Adapter.

Disk initialization

Initializing a disk writes necessary RAID configuration information to that disk.  Disks

must be initialized before configuring them into RAID arrays.  The initialization

process will destroy all data on the disk.

Disk Status

New        The disk contains no data and has not been initialized.

Initialized        The disk has been initialized and can be used for array creation.

Configured      The disk has been assigned to one or more arrays, or configured as a

spare disk.

Legacy        The disk was used on other controllers before use with the

RocketRAID 1720 (see legacy disk below).

Array initialization

A redundant array (RAID1) needs to be initialized to ensure full performance and

reliability.  Non-redundant arrays (RAID0, JBOD) do not need to be initialized.

When you create a redundant array using the RocketRAID 1720 controller’s BIOS

Configuration Utility, it will create the array in un-initialized state.  The initialization

process can be completed after installing the driver and management software.

When creating an array using the HighPoint RAID Management Console software,

you can specify an initialization option (Skip initialization, foreground and

background).
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Foreground initialization

Foreground initialization will zero-out all data on the array. The array is not accessible

by the operating system until initialization is complete.

Background initialization

Background initialization allows the array to be used immediately.  For RAID1 arrays,

initialization will results in data being duplicated identically to the mirror pair.

Note: An un-initialized RAID1 array can still provide redundancy in case of a disk

failure.

Online Capacity Expansion (OCE)

This feature allows disks to be added to existing RAID arrays, in order to increase the

array’s capacity, without fear of data loss.  Any number of disks can be added to an

array, at any time.  Data can be accessed and utilized even while being redistributed.

Online RAID Level Migration
This term describes the ability to change one type of array (RAID level), into a

different type of array.  Data is still accessible during the migration process.

Legacy disk

Disks attached to the RocketRAID 1720 that contain valid partition tables will be

identified as legacy disks.  A legacy disk attached to the RocketRAID 1720 can be

accessed by the operating system, but cannot be used to create RAID arrays.  A

legacy disk must be initialized before assigning it to an array.

Introduction
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RocketRAID 1720 Hardware

1 – RocketRAID 1720 Adapter Layout

Port1- Port2

These represent the RocketRAID 1720’s two SATAII channels.

BEEP1 - Speaker

Alarm (speaker): The speaker emits and audible alarm in the case of disk/array failure.

CON1

LED connectors for hard disk activity, and hard disk failure.

2 - LED Connections

The RocketRAID 1720 provides one LED connector, which supports Disk Activity

and Disk Failure LED’s.

Note: The connector was designed for use with SATA/SATAII backplanes.  Pins are

provided for signal only (no power or ground).
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Disk Activity (Pins 1 and 2)

Pin 2 represents SATA Port 1

Pin 1 represents SATA Port 2

Disk Failure (Pins 3 and 4)

Pin 3 represents SATA Port 1

Pin 4 represents SATA Port 2

3 - Installing the RocketRAID 1720 Host Adapter

Note: Make sure the system is powered-off before installing the RocketRAID 1720

host adapter.

The RocketRAID 1720 includes both standard and low-profile brackets.  It may be

necessary to attach the low-profile bracket in place of the standard bracket, depend-

ing upon the chassis design.

1. Open the system chassis and locate an unused PCI slot.

2. Remove the PCI slot cover.

3. Gently insert the RocketRAID 1720 into the PCI slot, and secure the bracket to

the system chassis.
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4. After installing the adapter, attach hard disks to the RocketRAID 1720 using an

SATA data cable.  SATA cables have universal connections – either end can be

attached to the adapter or hard disk.  Each RocketRAID 1720 included four

SATA cables, and supports up to four separate hard disks drives.

5. Many server-level chassis include hard-disk hot-swap bays.  For these system

chassis, cables are attached to the chassis backplane, rather than directly to

each individual hard disk.  Consult the chassis’s manual for proper installation

procedures.

6. Close and secure the system chassis.
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4 - Verifying Installation

Once the RocketRAID 1720 host adapter and hard disks have been installed into the

chassis, boot-up the system to verify that the hardware is properly recognized.

1. Power on the system.  If the system detects the presence of the adapter, the

RocketRAID 1720 BIOS Utility will be displayed during bootup.

2. Press Ctrl+H to access the RocketRAID 1720 BIOS Utility.

The BIOS Utility will display information about hard disks attached to the adapter.

Make sure all attached disks are detected by this utility.  If any of the hard disks are

not detected, power down the system and check the power and SATA cable

connections.
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RocketRAID 1720 BIOS Utility

The RocketRAID 1720’s BIOS Utility can be accessed using the “Ctrl+H” command.

This command should be displayed automatically when the RocketRAID 1720’s BIOS

screen appears during the system’s boot up procedure.

1 - BIOS Command Overview

The RocketRAID 1720 BIOS Utility provides a wide selection of RAID related

commands.  These commands are displayed towards the top of the utility’s interface.

Use the ← →arrow keys to scroll through the various commands, and the ↑ ↓
arrows to browse through the corresponding command menus.   Use the ENTER key

to execute the selected command.

The ESC button can be used to cancel the selected command, or return to the previ-

ous command menu.

Create - this command is used to create RAID arrays.   Section 2 discusses this

command in detail.

Delete - this command will delete the selected RAID array.

Warning:  This command may result in permanent data loss - it should only be used

if data stored on the target array is no longer relevant, or has been backed up to an

alternate storage device.

RocketRAID 1720 BIOS Utility
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Add/Remove Spare - this command is used to assign hard disks to function as

spare disks.  The controller is capable of using spare disks to automatically rebuild

broken or faulted RAID arrays.

Section 3 discusses this command in detail.

Settings

Select Boot Device - this function is used to designate a particular disk or RAID

array to function as the RocketRAID 1720’s boot device.

Note:  This setting is only relevant if the motherboard’s BIOS has set the

RocketRAID 1720 to function as the system’s primary boot device.

Staggered drive spin up – This function is used to enable (or disable) staggered

drive spin up support This setting, by default, is disabled.  Enabling staggered drive

spin up will power up the hard disks one at a time, approximately every two seconds.

View – this command is used to select between two views. Press the ENTER key to

change the view.

Devices – displays information about hard disks attached to the RocketRAID 1720.

Use the ↑ ↓ arrow keys to highlight the target hard disk, and press ENTER to view

the information.

RAID Arrays – displays information about RAID arrays attached to the RocketRAID

1720.  Use the ↑ ↓ arrow keys to highlight the target array, and press ENTER to view

the information.

Initialize - this function is used to prepare disks for use with RAID arrays.

Note:  Arrays cannot be created between disks that have not been initialized.

The following section discusses this command in detail.
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2 - Creating RAID Arrays

Initializing Disks:

Before creating a RAID array, the disks must be initialized.

Initialization writes necessary RAID configuration information to the hard disk.

Use the ← →arrow keys to select the Initialize command, and press ENTER.

Warning: Initialization will destroy all pre- existing data on the selected hard

disks.  This procedure will not be completed by the BIOS.   The RAID Management

Console software will initialize the array.

Use the ↑ ↓ arrow keys to highlight the target hard disk(s) and press ENTER.  Next,

press the Y (yes) key to initialize the selected disk(s), or N (no) key to cancel the

initialization process.

Once initialized, these disks can be utilized to create RAID arrays.

To create an array:

1. Use the ← → arrow keys to highlight the Create command, and press ENTER to

open the Create Menu.

2. Use the ↑ ↓ arrow keys to select the appropriate RAID level, then press ENTER.

3. Next, use the ↓ arrow key to highlight the Array Name option and press ENTER.

The array name dialogue box will appear.  Use the keyboard to input a new Array

Name, and press the Enter key.

Note: the Array Name command is optional – it is not necessary to name the

array.  The array can be named at a later time, and the name of the array can be

changed at any time.

4. On the Create menu, use the ↓ arrow key to highlight the Select Devices item and

press ENTER. A device list will appear, and display all available hard disk drives.

5. Highlight the target disks that you want to use, and press ENTER to select them.

After all of the disks have been selected, press the ESC key to return to the

Create Menu.
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6. Next, Use the ↓ arrow key to highlight the Capacity (GB) option and press

ENTER.  The total available capacity will be displayed.  Press ENTER if you wish

to use all available space.

7. If you wish to reserve disk space for additional arrays/single disks, use the

keyboard to input the amount of space (in GB) you wish to set aside for this

particular array, and press ENTER.

Note:  Multiple arrays can be created using the same set of hard disk drives.

The Capacity option allows you to set aside disk space that be used to create

another array, set as a spare disk, or partitioned to act as a single disk (by the

operating system).

8. To complete the creation procedure, use the ↓ arrow key to highlight the Start

Creation item and press ENTER.  Press the Y (yes) key to create the array, or N

(no) key to cancel the creation process.
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3 - Updating the BIOS

BIOS updates are released periodically, and posted on our website for download.

There are several ways to flash the RR1720 BIOS.

For Windows based operating systems:

1) Download the desired BIOS update from the Support section provided for

the RR1720 host adapter.  Extract the download to the directory of your

choice.

2) Insert the Driver and Software CD included with the RR1720 retail box into

the system’s CD-ROM or DVD drive.

3) The CD should autorun, and display the following screen:

4) Select the “Browse the CD” option, and access the directory provided for

the RR1720 host adapter.

5) Open the “BIOS” directory, and double click the “hptflash.exe” icon.  This

will start the BIOS flash utility:
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6) Select the RR1720 from the drop down menu labeled “Controller”, and press

the “Open” button – this will allow you to browse to the extracted BIOS

download (step 1).

7) Highlight the image file, and click the “Flash!” button.  The utility will update

the card, then verify the update.

8) Once complete, click on the “Exit” button to close the utility.  Shutdown and

reboot the system.

Note: the “Backup” button will save a copy of the card’s current BIOS to the

directory of your choice.

For other operating systems:

In order to update the BIOS, the system must be booted into DOS mode, using a

DOS-boot diskette or CD image.

1) Copy the load.exe and the bios image file to the bootable floppy diskette

(you may need to use a different floppy depending upon how much space is

available on the boot diskette - this can vary).

      2)    If you are booting from a CD image, you will need to add these files to the CD.

            Insert the boot image media into the appropriate drive, and boot the system.
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3)  Once the A:\> prompt has appeared, insert the media that contains the

required BIOS files, and type the following command:

load xxx.xxx

Then, press enter.

Note: xxx.xxx = the name of the BIOS image file (type it exactly as it

appears).

4)  The utility will scan for the controller, and ask if you want to backup the

BIOS (save a copy of the current BIOS to a floppy diskette).  This is optional

- you can answer No, and continue.

Note: This option will not function if the system was booted from CD.

5) The utility will then ask if you want to flash the controller (upgrade the

BIOS).  Select Y for yes.

6) The utility will display a progress bar during the flash procedure, then will

attempt verify the update.

7) Once complete, the system can be rebooted.
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Driver and Software CD

The RocketRAID 1720 retail box includes a Driver and Software CD.

This CD can be used to generate driver diskettes, and install the RAID Management

software for a variety of operating systems.

To create a driver diskette:

1. Insert the CD into the system’s CD/DVD drive.  The program should start

automatically.

2. Insert a blank floppy diskette into the system’s floppy drive.

3. Click on “Create Driver Diskette”.

4. Click on the “Please Select a Product” drop-down button, and select

‘RocketRAID 1720” from the list.

RocketRAID 1720 Driver and Software Installation
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5. Click on the “Please Select the Diskette you want to create” drop-down button,

and select the appropriate OS from the list.

6. Click on the “OK” button to create the driver diskette.

To install the RAID software:

1. Click on “Install RAID Management Software”.
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2. Select the desired software from the drop down menu, and click on the “OK”

button.

Windows Driver Installation

Before installing the RocketRAID 1720 device driver, make sure the RocketRAID 1720

host adapter and all required hard disks have been installed into the system’s chassis

(refer to the Hardware Installation section).

Installing the RocketRAID 1720 driver for an existing Windows XP/

2003/x64 system

After the operating system has booted, Windows will automatically detect the

RocketRAID 1720, and request that a device driver be installed.   To install the device

driver, follow the steps outlined below:

1. When the “Found New Hardware Wizard” window appears, select “Install from a

list or specific location (Advanced)”, and click Next to continue.

2. Click on the “Include this location in the search” option, and select the system’s

floppy drive (generally Disk A).  Next, insert the Driver Installation diskette into

the system’s floppy drive.

3. At the Hardware Wizard screen, select the floppy drive as the source, then click

the Next button.  Select the appropriate operating system folder, then click the

Next button.

4.   Windows will display a warning message that states the driver has “not been

signed”.  Select “Continue Anyway”, then click Finish when prompted. When
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 windows asks to reboot the system, choose No.

5. Windows will then display a second “Found New Hardware Wizard” window –

repeat steps 1 through 4.

6. Remove the Driver Installation diskette from the floppy drive, then Shut down

and restart the computer.

Installation Verification

After the driver has been installed, and the system has been restarted:

1. Click the Start button, then right-click My Computer icon.  Select the Properties

item from the popup menu.

2. In the popup window, select Hardware tab and then click Device Manager

button.

3. Double click the “SCSI and RAID controllers” entry.  If the RocketRAID 1720

device entry is not displayed, or there are “?” or “!” marks displayed near the

RocketRAID 1720 entry, the driver has not been installed properly. Delete the

entries and reinstall the driver.

Installing the RocketRAID 1720 driver during a fresh Windows

2000/XP/2003/x64 installation

1. After booting from the Windows 2000/XP/2003 CD-ROM, when the Windows

Setup blue screen appears, look towards the bottom of the screen.  Windows will

prompt you to press the F6 key if you want to install a third party SCSI or RAID

driver.  Press the F6 key at this time.

2. The setup procedure will continue, and will later instruct you to press the “S” key

to specify additional adapters. Press the “S” key as instructed.

3. Next, the setup program will prompt for the insertion of the driver diskette.  Please

insert the driver diskette, and then press ENTER to continue.

4. The next window will display several driver options.  Please select the

RocketRAID 1720 Controller for the corresponding operating system, and press

ENTER to continue.
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Installing the RocketRAID 1720 driver during a fresh Windows

Vista installation

1. Boot from Windows Vista DVD.

2. When the screen “where do you want to install Windows” appears, click   “Load

driver” and browse for the driver location. Windows Vista can install drivers from

several media types: floppy diskette, USB flash disk or CD.

3. Select the RocketRAID 1720 controller driver, and click “Next”.

4. The driver is now installed - you can now continue on with the installation

procedure.

Installing the RocketRAID 1720 driver for an existing Windows

Vista system

1. Install the RocketRAID 1720 host adapter into the PC, then boot up Windows

Vista.

2. Windows should automatically detect the card,  and display the “Found New

Hardware” wizard pop-up window.  Select “Locate and install driver software”.

When Windows asks: “Windows needs your permission to continue”, select

“continue”.

3. Select “I don’t have disc, show me other options” and then select “Browse my

computer for driver software”.

4. Specify the location of the driver and click “Next”.

5. When asked: “Would you like to install this driver software?”, select “Install”.

6. Reboot the system when prompted.  The RocketRAID 1720 will be available for

use after Vista reboot.

Installation Verification

After the driver has been installed, and the system has been restarted:

1. Click the Start button, then right-click My Computer icon.  Select the Properties

item from the popup menu.
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2. In the popup window, select Hardware tab and then click Device Manager

button.

Double click the “SCSI and RAID controllers” entry.  If the RocketRAID 1720 device

entry is not displayed, or there are “?” or “!” marks displayed near the RocketRAID

1720 entry, the driver has not been installed properly. Delete the entries and reinstall

the driver.

1 - Installing the RAID Management Console/ Interface

Overview

To install the RAID software, locate the setup.exe file located on the floppy diskette

labeled “DISK 1” (or the Disk1 folder, if the software was downloaded).  Double click

this file to start the Installation Wizard.

There is no need to restart the system after installing the software.  To start the

software, click on the “Start” button, select “Programs”, and click on the “HPT

Management Console.”

Logging On

The RAID Management Console requires that a user (or Administrator) log on.  The

software is incapable of working with RAID arrays or hard disks attached to the

RocketRAID 1720 until the user has logged on.
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Default Parameters:

System Address:  127.0.0.1

Port: 7402

User Name: RAID

Password: hpt

Logging On (continued)

Note: The password and user name fields are case sensitive.

The first time the software is used, make sure to enter the information listed above.

After successfully logging on, the software will ask you to alter the password (as a

security precaution).

Enter a password, and press enter.

2 - Software Interface - Overview of commands/func-

tions

After logging on, several new options will become available.

These commands are displayed towards the top of the interface window:

Overview of Function-menus (tabs)

File

Remote Control - view information about remote systems

System Configuration - switch between available remote systems

User Management - Add or remove users, edit user profiles

Password - change the password

Exit - exit the utility interface

Management

RAID Management – Create/delete/maintain RAID arrays
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Device Management - check information or change settings for host adapters, and

hard disks

Spare management - create and assign spare disks

System Notification - Set up system notification options

View

Event view - Views the event log

Icon view - view icon descriptions (legend)

Operation

This menu will list all available commands for the selected Function menu.

These commands are also represented in icon/button form (below the function-menu/

tabs selections)

Help

Search through help topics related to the RAID Management Console software

View software version information

3 - Creating an Array

To create an array:

1. Highlight the “Management” menu, then select the “Array Management”

function.

2. Click the Create button on the toolbar or select the “Create” command from the

“Operation” menu.  The array creation wizard will appear.
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3. Select the desired RAID level from the drop-down list.

4. Enter a name for the array using the keyboard (this is optional), and click the Next

button.

5. If you are creating a redundant array (RAID 1), select an initialization option.  If

you are creating a RAID 0 or JBOD (volume), skip to step 6:

For RAID1 arrays, the default initialization method is “No initialization”.

6. Select which disks are to be used to create the array.  Highlight the desired disk

from the left-side of the interface (available disks), then click on the  button

to move the disk to the right side of the interface (selected disks).  Disks must be

selected one a time.

If you wish to remove a selected disk, highlight it from the selected disk section,

and use the  button to move it to the available disk section.

Note:  The selection sequence is important - the order in which the disks are

selected will determine the disk sequence of the array.

7. Select the capacity - the RocketRAID 1720 can create arrays between partitions

on various disks.  It is not limited to physical hard disk drives.  As a result of this

feature, you have the option of assigning a physical disk to multiple RAID

arrays.
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Press Enter to use the default value (the maximum capacity for the array), or

specify the desired value using the keyboard, and press Enter to confirm this

selection.  Then, click the Finish button.

Note: If you have specified an initialization option, the initialization process will start

automatically.  A progress bar will be displayed towards the bottom of the interface

window, and will indicate % completion, and provide an estimate of the time needed

to complete the initialization procedure.

4 - Deleting an Array

To delete an array:

1. Highlight the “Management” menu, then select the “Array Management”

function.

2. Highlight the array you want to delete, then click on the “Delete Icon” or select

the Delete command from the “Operation” menu.

3. A warning message will appear. Click Yes to delete the array.  Click on cancel to

stop this procedure.

Note: An array in use by the operating system cannot be deleted. Any data stored on

a deleted array will be inaccessible

5 - Configuring Spare Disks

Spare disks can be used to rebuild redundant RAID arrays in the case of failure.

To configure spare disks, highlight the “Management” menu, and select the “Spare

Management” function. The Spare Management window will appear.

To add a spare disk, select it from the Available Disk list box and click the  button

to add the disk to the Spare Pool list box.

To remove a spare disk, select it from the Spare Pool list box and click the  button

to remove the disk from the Spare Pool list box.

6 - Recovering/Verifying Arrays
When an array member (hard disk) of a redundant array fails, the array will be marked
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as “broken”.

Broken arrays can be automatically rebuilt using hot-spare disks.

However, if there are no available spare disks, you can still rebuild the array by

adding a new disk to it. To add a disk to a broken array:

1. Highlight the “Management” menu, and select the “Array Management”

function.

2. Highlight the broken array that needs to be rebuilt.

3. Click the Add Disk button on the toolbar or select “Add Disk” command from the

“Operation” menu.

4. If the disk is successfully added to the array, rebuild process will start

automatically.

Note: In some instances, a failed array will not rebuild automatically.

To manually start the rebuild process for a broken/critical array:

1. Highlight the “Management” menu, and select the “Array Management”

function.

2. Highlight the array that needs to be rebuilt.

3. Click the Rebuild button on the toolbar or select the “Rebuild” command from the

“Operation” menu.

Verifying an Array

For a RAID 1 array, the verify process compares the data of one disk to the other .

Verification checks each sector on a given disk.  Periodic verification of an array

allows the disk drive firmware to take corrective actions on problem areas on the disk,

minimizing the occurrence of uncorrectable read and write errors.

To verify an array:

1. Highlight the “Management” menu, and select the “Array Management” function.

2. Highlight the array you want to verify.

3. Click the Verify button on the toolbar or select the “Verify” command from the

“Operation” menu.

4. Verify process will start.
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7 – OCE/ORLM

The RR1720 supports both OCE (online capacity expansion) and ORLM (Online RAID

Level Migration).  This allows you to convert a RAID array to another type of RAID

array (ORLM), or add additional space to an existing RAID array (OCE).

The RAID software provides support for these features through a single function,

known as OCE/ORLM.

With the OCE/ORLM function, you can transform an array from one RAID level to

another RAID level and/or resize the array dynamically, even under I/O load.

To perform OCE/ORLM on an array:

1. Highlight the “Management” menu, and select the “Array Management”

function.

2. Highlight the array you want to alter.

3. Click the  button on the toolbar or select “OCE/ORLM” command from

the “Operation” menu.

4. The OCE/ORLM window will appear.

5. The interface is very similar to the Array Creation Wizard interface.  Select the

type of array you wish to change the existing array into, then set any corre-

sponding parameters (cache/ initialization options, capacity, if relevant).

Notes:

1. You cannot change an array to another type of array with a smaller capacity.

In some cases, a disk may need to be added to the RocketRAID 1720.

2. During the OCE/ORLM procedure, the redundancy level of the array will be

the lowest of the source and target arrays; e.g. if you ORLM a JBOD array to

a RAID1 array, the array will be non-redundant until the procedure is

complete.

3. The OCE/ORLM process can be aborted and continued at later time.
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However, you should always stop the transform progress from the RAID Manage-

ment software.

4. An unexpected system crash may result in data loss while performing OCE/

ORLM on an array.

8 - Misc. Array/Device Options

Device Management

The Device Management window provides configuration information about control-

lers (the RocketRAID 1720 and other HighPoint host adapters), channels and hard

disks.

To access the Device Management window, highlight the “Management” menu, and

select the “Device Management” function.

Changing Device Settings

Depending upon the hard disk in question, and support provided by the current

device driver, you can adjust settings for disk: Read Ahead, Write Cache, TCQ, and

NCQ.   Each feature can be enabled or disabled individually.

S.M.A.R.T Status

You can view S.M.A.R.T. (Self-Monitoring, Analysis, and Reporting Technology)

data about a drive to help troubleshoot any problems that occur. You can also setup

periodical S.M.A.R.T. status checks that send notification messages when S.M.A.R.

T. thresholds are exceeded.

To view the S.M.A.R.T status of a hard disk:

1. Highlight the “Management” menu, and select the “ Device Management”

function.

2. Highlight the disk you want to examine.

3. Select the “SMART” command from the “Operation” menu, or click on the 

button to display the S.M.A.R.T status/settings window.
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Renaming an Array

1. Highlight the “Management” menu, and select the “Array Management”

function.

2. Highlight the array you want to rename.

3. Click the Rename button on the toolbar or select the “Rename” command from

the “Operation” menu.

4. Enter a new name for the array using the keyboard, and press the OK button to

confirm your selection.

Note: An array running background tasks cannot be renamed.

9 - Managing Events

The HighPoint RAID Management Console will log all events that have occurred on

any host adapter under it’s control.

Viewing Logged Events

To view logged events:

1. Highlight the “View” menu, and select the “Event View” option.

2. In the Event View window, you can filer events, clear events, and save events to a

file.

Configuring E-mail notification

To enable E-mail notification:

1. Highlight the “Management” menu, and select the “Event Notification” function.

2. Click the Setting button on the toolbar or select “Setting” option from the

“Operation” menu.

3. Next, enter the necessary information in the E-mail Notification Setting window.
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Note: The software does not support SMTP servers that require user authentication.

To add a Recipient:

1. Highlight the “Management” menu, and select the “Event Notification” function.

2. Click the “Add” button on the toolbar or select “Add” command from the

“Operation” menu.

3. Enter the necessary information in the Add recipient window.

4. The recipient will be listed in the main window. You can use Modify or Delete

button on the toolbar to modify or delete the recipient.
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To test E-mail notification:

1. Highlight the “Management” menu, and select the “Event Notification” function.

2. Select one recipient from the main window.

3. Click the Test button on the toolbar or select the “Test” command from the “Opera-

tion” menu.

4. The software will send a “test” e-mail message to the selected recipient.

Managing Tasks

The RAID management Console can be used to setup routine, periodical background-

rebuild or verification tasks that will help maintain the integrity of RAID arrays

attached to the RocketRAID 1720.

To setup and schedule tasks highlight the “Management” menu, and select the “Task

Management” function to open Task Management window.

The Task Schedule list displays all of the tasks assigned to the selected remote

system.  To view detailed information about a specific task, highlight and Double-click

the task’s name.

Add a Scheduled Task

This command is used to add a Scheduled task for the selected remote system.
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 To add a new scheduled task:

Click the “New” button on the toolbar.  The new task schedule wizard will appear.

Select the task type and the array that you want to verify or rebuild, then click “Next”.
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1. Enter a name for the task.

2. Configure the frequency for the task.

3. Set the duration for the task.

4. Check the “Enable the task” option to activate this task.

5. Click “Finish”.

Modify a Scheduled Task

This command is used to change settings for a scheduled task.  To Modify a Task

Schedule:

1. Select a task from the Task schedule list.

2. Click the “Modify” button on the toolbar, and modify the task settings in the

popup window.

Delete a Scheduled Task

This command is used to delete a Scheduled Task for the selected remote system.  To

delete a Task Schedule:

1. Select a task from the Task schedule list.

2. Click the “Delete” button on the toolbar.

10 - Configuring Remote Systems

Then HighPoint RAID Management Console manages a RAID controller through a

connection to the HighPoint RAID Management Service, which runs on the system

where the RAID host adapter is physically installed.  This type of system is referred

to as a “remote system”.

Note: What the software classifies as a “remote system” may not always be an actual

remote computer.   In some configurations, the local computer hosts both the RAID

host adapter and Management Service.  The local system, in these cases, is still

generically referred to as a “remote system”.

Add a Connection

This command is used to add new connection to a remote system.  To Add a

Connection:
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1. Highlight the “File” menu, and select the “Remote Control” function.

2. Click the Add button on the toolbar or select the “Add” command from the “Opera-

tion” menu.

3. Enter the system address, name, and port information in the popup window.

The system address can be a host name, or an IP address.  The default system port is

7402.

4. Click “OK” to finish adding the new connection.

Modify a Connection

This command modifies connection information for a remote system.  To modify a

connection:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to modify.

3.   Click the Modify button on the toolbar or select the “Modify” command from the

“Operation” menu.

4. Enter new connection information in the popup window, and click OK to apply

the changes.
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Note: The System Address cannot be modified.  If you insist on modifying this item,

you must first delete this connection and then add a new connection.  In addition, the

connected system cannot be modified – you must first disconnect from this system.

Delete a Connection

This command deletes a remote system from the connection list.  To delete a

connection:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to delete.

3. Click the “Delete” button on the toolbar or select the “Delete” command from the

“Operation” menu.

4. A warning message will be displayed.  Click “Yes” to delete the item.  Select No to

cancel this command.

Connect to a Remote System

This command establishes a connection to a remote system for RAID management.

To connect to a remote system:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the remote system you to establish a connection with.

3. Click the “Connect” button on the toolbar or select the “Connect” command from

the “Operation” menu.

4. Enter the appropriate Login information in the popup window.
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Note: The initial user name/password for a remote system is RAID/hpt.  You are free

to modify the username and password after the connection is established.

If the connection is successful established, the application will retrieve the event logs

from the remote system, then switch to Array Management view.

Disconnect Remote System

This function closes the connection from a connected system.  To disconnect a

remote system:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to disconnect from.

3. Select the “Disconnect” command from the “Operation” menu.

System Configuration

This function is used to modify the service configuration on a remote system.  To

change the service configuration:

1. Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the remote system you want to modify.

3. Select the “System Configuration” option from the “Operation” menu.

4. Modify the information in the popup window.

System Port - This is the TCP port number that the RAID Management Service uses

to communicate with RAID Management Console.  When you connect to the service,

the port value you enter must be in accordance with the system port value on the

service.  The default value is 7402.

21



RocketRAID 1720 Driver and Software Installation

4 -

Event Port - The client software will retrieve events through this port.  The default

value is 7403.

The System Port value must differ from the value assigned to the Event Port.  After

you reset a system’s configuration, you should restart the service on that system for

the changes to take effect.

5. Click “OK” to apply the changes.

11 - Configuring Users and Privileges

The RAID Management Console allows the Administrator to manage user accounts in

its own database. You can setup multiple users and assign different privileges levels

for the purpose of RAID management.

Users can be assigned to each individual Remote System controlled by the RAID

Management Console.

Highlight the “File” menu and select the “User Management” function to configure

User related options for the selected remote system.

The user management window lists all users assigned to the selected remote system.

The current/active user will be designated with an icon.

Add a User

This function adds a user account to the connected remote system.  To add a user:
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1. Click the “Add” button in the User Management window.

2. In the popup window, enter the user name, enter and confirm the password, and

then click “Next”.

3. Select the appropriate privileges for the user.

4. Click “Finish”.

Delete a User

This function deletes a user’s account on the connected remote system.  To delete a

user:

1. Select the target user ID from the User list displayed in the User Management

window.

2. Click Delete to remove the selected user. Click “Yes” to delete the item.  Select “No”

to cancel this command.

Note: An active user (user currently utilizing the software) cannot be deleted from the

console.

Set Password

The Administrator uses this function to set a user’s password – the password allows

a user to log on to a remote system, and utilize the RAID Management Console.  To

set password for a user:

1. Select the target user ID from the user list displayed in the User Management

window.
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2. Click the “Set Password” option, and enter the password for the user.

3. Click OK to apply your selections.

Set Privilege

The Administrator uses this function set a user’s privileges for the selected remote

system.  To set privileges for a user:

1. Select the target user ID from the user list displayed in the User Management

window.

2. Click the “Set Privilege” option.

3. In the popup window, assign the privileges for the selected user.

4. Click OK to apply your selections.
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1 – Fedora Core 6 Linux installation Overview

This section provides instructions describing how to install and utilize the

RocketRAID 1720 Adapter on a Fedora Core 6 Linux system.

2 - Installing Fedora Core 6 on the RocketRAID 1720

Host Adapter

Note: If the OS is running kernel that differs from the one supported by the

precompiled driver, the precompiled drivers cannot be used.  A driver can be built for

this kernel using the OpenSource package for the RocketRAID 1720 controller.   This

package is available from our website, and is posted on the BIOS/Driver page for the

RocketRAID 1720.

To install Fedora Linux onto hard disks or RAID arrays attached to RocketRAID 1720

controller, follow the steps outlined below:

Step 1 Prepare the Driver Diskette

The driver is contained in a floppy diskette image file.

On a DOS or Windows system, a Fedora driver diskette can be generated using

rawrite.exe.  This utility is included on the Fedora Linux CD (under /dosutils).  Run

rawrite using a command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette.  Insert a

floppy disk into the floppy drive and type the following command:

          # dd if=fcX-i386.img of=/dev/fd0

Note: The driver disk image file depends on your core version and hardware.

Step 2 Install Fedora Linux

Installation steps for Fedora Core 6

1) Boot from the Fedora Installation CD, and start the install procedure.

2) At the “Welcome to Fedora Linux” installation screen, a prompt labeled “boot:” will

appear at the bottom of the screen.  Type in linux dd, then press Enter.

boot: linux dd
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3) When prompted “Do you have a driver disk?”, select “Yes”.  At the “Insert your

driver disk and press OK to continue” prompt, insert the driver diskette in the floppy

drive and then select “OK”.

4) The system will now load the RocketRAID 1720 driver automatically.

3 - Installing the RocketRAID 1720 driver for an Exist-

ing System

Note: If a SCSI adapter is used to boot the system, make sure the RocketRAID 1720

controller BIOS loads/posts after the SCSI adapter’s BIOS.  It may be necessary to

move the adapter(s) to another PCI slot.

Step 1 Obtain the Driver Module

Extract the module file from the file modules.cgz (from the driver disk) using the

following commands:

      # mount /dev/fd0

       # cd /tmp

      # gzip -dc /media/floppy/modules.cgz | cpio -idumv

Driver modules for all supported kernel versions will be extracted. The driver module

for the active kernel is located under the directory that matches the kernel version (/

tmp/‘uname –r‘/i686/rr172x.ko).

After extracting the driver module, load it using the following commands:

# modprobe sd_mod

# insmod rr172x.ko

Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda).

Step 2 Mounting and Partitioning the Device

Example: A RAID array has been configured between several hard disks.

 This array will be registered to the system as device “/dev/sda”.

      To create a partition on this array (which will listed as /dev/sda1), use the “fdisk /

dev/sda” command.

Next, use the “mkfs /dev/sda1” command to setup a file system on this partition.
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       Use the command “mkdir xxxx” to create a mount point for the RAID array.  Then

mount /dev/sda1 /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr172x.ko” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup. To install

the module, type in the following commands (first change to the directory where the

proper rr172x.ko file is located):

#cp rr172x.ko /lib/modules/‘uname –r‘/kernel/drivers/scsi

#depmod

Then, instruct the system to load the module when booting.  Use the following

commands:

#echo “modprobe rr172x” > /etc/init.d/hptdriver

#chmod 755 /etc/init.d/hptdriver

#ln –sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/S01hptdriver

       #ln –sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/S01hptdriver

       #ln –sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/S01hptdriver

Step 4 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by

modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sda1 to location /

mnt/raid after startup:

/dev/sda1       /mnt/raid           ext3    defaults   0 0

4 - Updating the Driver

1. If the original driver is installed in the system’s initrd (Initial RAM Disk) file

(when using a system installed to the RocketRAID 1720 controller, for example),

the driver module in the initrd file should be updated using the mkinitrd com-

mand (or extract the initrd file and replace the driver module manually).
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2. If the original driver is installed in the /lib/modules/‘uname –r‘/kernel/drivers/

scsi/ directory, and loaded by the script file (Example /etc/init.d/hptdriver) during

the init process, or the configure file (Example /etc/modules.conf), please replace

it with the new driver (rr172x.o or rr172x.ko).

5 - Installing the RAID Management Software

The HighPoint RAID Management Software is used to configure and keep track of

your hard disks and RAID arrays attached to RR1720 controller. Installation of the

management software is optional but recommended. To configure HighPoint RAID

Management Software to work with RR1720 driver, you should setup /etc/hptcfg to

be the driver name:

 # echo rr172x > /etc/hptcfg

Please refer to HighPoint RAID Management Software documents for more

information.

6 - Uninstalling the Driver

To uninstall the RocketRAID 1720 driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array

attached to the RocketRAID 1720.

To uninstall the driver, remove the lines added to /etc/fstab, and remove the files

created in the /etc/init.d directory.
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1 - Red Hat Enterprise 4 Overview

This section provides instructions describing how to install and utilize the

RocketRAID 1720 Adapter on a Red Hat Enterprise 4 Linux system.

2 - Installing Red Hat Enterprise 4 (AS, ES, WS) Linux

on the RocketRAID 1720 controller

To install Red Hat Enterprise Linux onto disks or RAID arrays attached to

RocketRAID 1720:

Step 1 Prepare the Driver Diskette

The driver is provided in a floppy diskette image file format.

On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.

This utility is included on the Red Hat Enterprise Linux CD (under /dosutils).  Run

rawrite using a command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette.  Insert a

floppy disk into the floppy drive and type the following command (amd64 driver for

example):

# dd if=rh3dd-amd64.img of=/dev/fd0

Step 2 Install Red Hat Enterprise Linux

Start installing Red Hat Enterprise Linux by booting from the installation CD.

At the “Welcome to Red Hat Linux” installation screen, a prompt labeled “boot:” will

appear at the bottom of the screen.  Type in linux dd, then press Enter.

             boot: linux dd

When prompted “Do you have a driver disk?”. Select “Yes”.

When prompted “Insert your driver disk and press OK to continue”, insert the driver

diskette into the system’s floppy drive, and select “OK”.

1. The system will now load the RocketRAID 1720 driver automatically.

2.   When prompted “Where do you want to install the boot loader? ” in the “Boot

Loader Configuration” dialog, select “Master Boot Record (MBR)” to instruct
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the system be to boot from the RocketRAID 1720.

Continue the installation as normal. You can refer to Red Hat Enterprise Linux installa-

tion guide.

Note:

1. The system device mapping order is the same as the order shown in RocketRAID

1720 BIOS Setting Utility.  If no other SCSI adapters are installed, the device marked

as “BOOT” or “HDD0”will identified as /dev/sda, “HDD1” as /dev/sdb, “HDD2” as

/dev/sdc, etc.  When creating mount points, /boot must be mounted on /dev/sda.

3 - Installing the RocketRAID 1720 driver for an Exist-

ing System

Note: If a SCSI adapter is used to boot the system, make sure the RocketRAID 1720

controller BIOS loads/posts after the SCSI adapter’s BIOS.  It may be necessary to

move the adapter(s) to another PCI slot.

Step 1 Obtain the Driver Module

Extract the module file from the file modules.cgz (from the driver disk) using the

following commands:

# mount /dev/fd0

# cd /tmp

# gzip -dc /mnt/floppy/modules.cgz | cpio -idumv

Driver modules for all supported kernel versions will be extracted. The driver module

for the active kernel is located under the directory that matches the kernel version (/

tmp/‘uname –r‘/rr172x.ko).

After you have extracted the driver module, you can load it by following commands:

     # modprobe sd_mod

      # insmod rr172x.ko

Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda).

Step 2 Mounting and Partitioning the Device

Example: A RAID array has been configured between several hard disks.

 This array will be registered to the system as device “/dev/sda”.
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      To create a partition on this array (which will listed as /dev/sda1), use the “fdisk /

dev/sda” command.

      Next, use the “mkfs /dev/sda1” command to setup a file system on this partition.

      Use the command “mkdir xxxx” to create a mount point for the RAID array.  Then,

mount /dev/sda1 /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr172x.ko” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup. To install

the module, type in the following commands (first change to the directory where the

proper rr172x.ko file is located):

# install -d /lib/modules/‘uname –r‘/kernel/drivers/scsi

        # install -c rr172x.ko /lib/modules/‘uname –r‘/kernel/drivers/scsi

Then, instruct the system to load the module when booting.  Use the following

commands:

#echo “modprobe rr172x” > /etc/init.d/hptdriver

#chmod 755 /etc/init.d/hptdriver

#ln –sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/S01hptdriver

       #ln –sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/S01hptdriver

       #ln –sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/S01hptdrive

Step 4 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by

modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sda1 to location /

mnt/raid after startup:

/dev/sda1       /mnt/raid           ext2    defaults   0 0
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4 - Updating the Driver

If you are not booting from disks attached to RocketRAID 1720 controller, you can

update the driver just by reinstalling it following the procedure outlined in the

previous section, “Installing the RocketRAID 1720 driver for an Existing System”.

If you are running the system installed to a disk or array attached to the RocketRAID

1720:

      First, obtain the new driver module “rr172x.ko”. Refer to the previous section

“Obtain the Driver Module”.  In following steps, we assume it has been copied to

“/tmp/rr172x.ko”.

       Replace rr172x.o in the boot RAM disk image, /boot/initrd-xxx.img (where xxx is

the kernel version).

Example: (2.4.21-4.EL for Red Hat Enterprise Linux 3.0):

# gzip -dc /boot/initrd-xxx.img > /tmp/initrd.ext2

# mkdir /mnt/initrd

# mount -o loop /tmp/initrd.ext2 /mnt/initrd

# cp /tmp/rr172x.o /mnt/initrd/lib/rr172x.o

# umount /mnt/initrd

# gzip -c /tmp/initrd.ext2 > /boot/initrd-xxx.img

If you are using lilo to boot the system, use “lilo” to reinstall the RAM disk:

# lilo

Update rr172x.o in /lib/modules:

# cp /tmp/rr172x.ko /lib/modules/‘uname –r‘/kernel/drivers/scsi/rr172x.ko

Reboot your system to allow the new driver take effect.

5 - Uninstalling the Driver

To uninstall the RocketRAID 1720 driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array

attached to the RocketRAID 1720.

To uninstall the driver, remove the lines added to /etc/fstab, and remove the files

created in the /etc/init.d directory.
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1 – SuSE Linux Enterprise Server (SLES) installation

Overview

This section provides instructions describing how to install and utilize the

RocketRAID 1720 Adapter on a SuSE (SLES) Linux system.

2 - Installing SLES Linux on the RocketRAID 1720

Host Adapter

Note: If the OS is running kernel that differs from the one supported by the

precompiled driver, the precompiled drivers cannot be used.  A driver can be built for

this kernel using the OpenSource package for the RocketRAID 1720 controller.   This

package is available from our website, and is posted on the BIOS/Driver page for the

RocketRAID 1720.

To install SLES onto hard disks or RAID arrays attached to RocketRAID 1720

controller, follow the steps outlined below:

Step 1 Prepare the Driver Diskette

The driver is contained in a floppy diskette image file (slesdd.img).

On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.

This utility is included on the SLES Linux CD (under /dosutils).  Run rawrite using a

command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette.  Insert a

floppy disk into the floppy drive and type the following command:

# dd if=SLESdd.img of=/dev/fd0

Step 2 Install SLES Linux

1. Start the install procedure by booting from SLES installation CD.

2. After the CD boots, select the “Installation” option and press F6 to load the

driver.

3. Insert the Driver Diskette when it displays “Please insert the Driver Update

floppy”.

9



Linux Driver Support

5 -

4. When the “Diver Update Menu” is displayed, press “OK” and “back” for back

to installer.

5. Next. Select “back” to return to the installer.

6. Installation will now proceed normally. Refer to SLES Linux documents for

additional OS installation procedures.

Additional Installation Notes:

The system device mapping order is the same as the order shown in RocketRAID

1720 BIOS Setting Utility.  If no other SCSI adapters are installed, the device marked

as “BOOT” or “HDD0” will be identified as /dev/sda, “HDD1” as /dev/sdb, “HDD2”

as /dev/sdc, etc.  When creating mount points, /boot must be mounted on /dev/sda.

3 - Installing the RocketRAID 1720 Driver on an Exist-

ing System

If you are currently running SLES and would like to access drives or arrays attached

to the Rocket RAID 1720 controller, follow the steps outlined below:

Note:

1. If a SCSI adapter is used to boot the system, make sure the RocketRAID

1720 controller BIOS loads/posts after the SCSI adapter’s BIOS.  It may be

necessary to move the adapter(s) to another PCI slot.

2. The driver may work incorrectly on certain motherboards (such as DFI77B

KT400). For these motherboards, add the “acpi=off” kernel parameter in the /

boot/grub/menu.lst:

kernel (hd0,1)/vmlinuz root=/dev/hda1 acpi=off

initrd (hd0,1)/initrd

Step 1 Update Grub

If you are running an SLES SMP System, you must first update the /boot/grub/menu.

lst.

Example:

default=0

timeout=8
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title Linux

kernel (hd0,1)/vmlinux root=/dev/hda1 acpi=off

initrd (hd0,1)/initrd

Reboot the system to allow the new kernel parameters to take effect.

Step 2 Install the Driver Module

Extract the module file from the file /linux/suse /[arch]-[version]/install/update.tar.gz

(from the driver disk), using the following commands:

 # mount /dev/fd0 /mnt/floppy

# cd /

# tar xfz /mnt/floppy/linux/suse/i386-sles9/install/update.tar.gz

The driver modules will be extracted to the directory /lib/modules/[kernel-ver]/kernel/

drivers/scsi/ .

After you have extracted the driver module, you can load it by following commands:

# modprobe sd_mod

# insmod rr172x.ko

Then you can access the arrays attached to the controller as SCSI devices (e.g. /dev/

sda).

Step 3 Mounting and Partitioning the Device

Note: Many versions of SuSE include YAST.  YAST is a graphical configuration

utility that is capable of executing the commands described below.  We recommend

using YAST, if available, as it may help simplify the installation process.

Example: A RAID array has been configured between several hard disks.

 This array will be registered to the system as device “/dev/sda”.

1. To create a partition on this array (which will listed as /dev/sda1), use the

“fdisk /dev/sda” command.

2. Next, use the “mkfs /dev/sda1” command to setup a file system on this

partition.
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3. Use the command “mkdir xxxx” to create a mount point for the RAID array.

Then, mount /dev/sda1 /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 4 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr172x.o” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup. To install

the module, type in the following commands (first change to the directory where the

proper rr172x.ko file is located):

1. Edit the file “/etc/sysconfig/kernel”, and add the RR1720 module to the line

“INITRD_MODULES=…”

Example:

INITRD_MODULES=”reiserfs RR172x”

2. Run the “depmod” command to update the module configuration:

# depmod

3. Next, run the “mkinitrd” command to update the initrd file:

# mkinitrd

4. If you are using the lilo boot loader, run lilo again:

# lilo

Step 5 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by

modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sda1 to location /

mnt/raid after startup:

/dev/sda1       /mnt/raid           ext2    defaults   0 0

12



4 – Updating the Driver

To update the driver, simply reinstall the driver following the steps in previous

section, “ Install RocketRAID 1720 Driver on an Existing System “.

Note: If the driver is loaded in initrd (when system is installed onto a disk or array

attached to the RocketRAID 1720), you need to run the mkinitrd command to update

the initrd file. If you are using the lilo boot loader, run lilo again (# lilo).

5 - Uninstalling the Driver

To uninstall the RocketRAID 1720 driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array

attached to the RocketRAID 1720.

To uninstall the driver, remove the lines added to /etc/modules.conf and /etc/fstab.

Linux Driver Support

5-13



Chapter 6
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1 - Installing FreeBSD on the RocketRAID 1720 Con-

troller

If you would like to install FreeBSD onto arrays attached to the RocketRAID 1720

host adapter, please follow the steps below.

Step 1 Prepare the Driver Diskette

When installing FreeBSD to a disk or array attached to the RocketRAID 1720, you

must prepare a RocketRAID 1720 driver diskette before starting the installation

procedure.

First, obtain the driver diskette image file from the driver package.

In a DOS or Windows system, create the boot diskette using the rawrite.exe utility.

This utility can be found on the FreeBSD CD (under \tools). Run it under a DOS-

Prompt window and follow it’s prompt.

On a FreeBSD system, use the “dd” command to make the driver diskette. For

example, Insert a floppy disk into the floppy drive and type the following command (if

you are installing FreeBSD 5.x versions):

          # dd if=freebsd_5.x.img of=/dev/fd0

Step 2 Install FreeBSD

1. Start the FreeBSD installation procedure by booting from installation CD.

2. If you are installing FreeBSD 5.0 or earlier versions, skip this step. When the

“Welcome to FreeBSD” screen appears, select “6”.

3. When the “Hit [enter] to boot immediately or any other key for command

prompt” screen appears, press the SPACE key to stop the loader from

autobooting.

BTX loader 1.00  BTX version is 1.01

Console: internal video/keyboard

BIOS driver A: is disk0

BIOS driver B: is disk1

BIOS driver C: is disk2
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BIOS 636kB/74512kB available memory

FreeBSD/i386 bootstrap loader, Revision 0.8

(mailto:jkh@narf.osd.bsdi.com, Sat Apr 21 08:46:19 GMT

2001)

-

Hit [Enter] to boot immediately, or any other key for

command prompt.

Booting [kernel] in 9 seconds…

 <-press SPACE key

A prompted label “ok” will appear at the bottom of the screen.

4. Insert the RocketRAID 1720 driver diskette into floppy drive. Type in “load

diskx:rr172x-x.x”  (without quotation marks), and then press enter.

for FreeBSD 4.3-RELEASE

ok load kernel

ok load disk1:rr172x-4.3.ko

for FreeBSD 4.4-RELEASE

ok load kernel

ok load disk1:rr172x-4.4.ko

for FreeBSD 4.5-RELEASE

ok load disk1:rr172x-4.5.ko

for FreeBSD 4.6.2-RELEASE

ok load disk1:rr172x-4.6.2.ko

for FreeBSD 4.7-RELEASE

ok load disk1:rr172x-4.7.ko

for FreeBSD 4.8-RELEASE

ok load disk1:rr172x-4.8.ko

for FreeBSD 4.9-RELEASE

ok load disk1:rr172x-4.9.ko
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for FreeBSD 4.10-RELEASE

ok load disk1:rr172x-4.10.ko

for FreeBSD 4.11-RELEASE

ok load disk1:rr172x-4.11.ko

for FreeBSD 5.0-RELEASE

ok load disk0:rr172x-5.0.ko

    for FreeBSD 5.1-RELEASE

ok load disk0:rr172x-5.1.ko

     for FreeBSD 5.2.1-RELEASE

ok load disk0:rr172x-5.2.1.ko

     for FreeBSD 5.3-RELEASE

ok load disk0:rr172x-5.3.ko

    for FreeBSD 5.4-RELEASE

      ok load disk0:rr172x-5.4.ko

    for FreeBSD 5.3-AMD64-RELEASE

      ok load disk0:rr172x-5.3-amd64.ko

    for FreeBSD 5.4-AMD64-RELEASE

      ok load disk0:rr172x-5.4-amd64.ko

5. After the driver has been loaded, remove the floppy diskette from the floppy

drive.

6. Type in “boot” and continue with installation as normal. Refer to FreeBSD

installation guide for additional information.

ok boot

Note: On some systems, when ACPI is enabled, FreeBSD may not function

properly. Try disabling ACPI in the motherboard’s BIOS settings, or type the

command “set hint.acpi.0.disabled=”1”” under the boot prompt, in order to

solve the problem.
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7. Before exiting installation, an additional step must be taken to copy the

RocketRAID 1720 driver module to the system. On the driver diskette, there is a

setup script labeled “postinstall”, which will complete this task. Before rebooting

the system, press Alt-F4 to enter the command shell, and type the following

commands:

# mount –o ro /dev/fd0 /mnt

# sh /mnt/postinstall

# umount /mnt

Then, press Alt-F1 to return to the setup screen, and choose [X Exit

Install] to finish setup.

2 - Installing the RocketRAID 1720 Driver on an Exist-

ing System

If you are currently running FreeBSD and would like to access drives or arrays

attached to the RocketRAID 1720 Controller, follow the steps outlined below:

Step 1 Copy the Driver Module

If you have made FreeBSD drivers into a diskette, you can insert the driver diskette to

floppy drive, then using the following commands to copy the driver module:

For FreeBSD 4.x:

# mount –o ro /dev/fd0 /mnt

# cp /mnt/rr172x-xxx.ko /modules/rr172x.ko

# umount /mnt

For FreeBSD 5.x:

# mount –o ro /dev/fd0 /mnt

# cp /mnt/rr172x-xxx.ko /boot/kernel/rr172x.ko

# umount /mnt

Alternately, it is possible extract the files from the .img files directly, without using a

floppy diskette:
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    For FreeBSD 4.x:

# vnconfig vn0c freebsd_xxx.img

# mount /dev/vn0c /mnt

# cp /mnt/rr172x-xxx.ko /modules/rr172x.ko

# vnconfig –du vn0c myfilesystem mount=/mnt

For FreeBSD 5.x:

# mdconfig –a –t vnode –f freebsd_5.x.img –u 0

# mount /dev/md0 /mnt

        # cp /mnt/rr172x-xxx.ko /boot/kernel/rr172x.ko

# umount /mnt

# mdconfig –d –u md0

Step 2 Test the Driver Module

Test the driver module to ensure that it works with the system, by loading it during

bootup.   If the module has been loaded successfully you should see the RocketRAID

1720 banner and a display screen of the attached drives. You can now access the

drives as a SCSI device.

Note:If you have no other SCSI device, the first device is /dev/da0, then /dev/da1,etc.

Example:       F1 FreeBSD

Default: F1

>> FreeBSD/i386 BOOT

Default: 0:ad(0,a)/boot/loader

boot:

BTX loader 1.00  BTX version is 1.01

Console: internal video/keyboard

BIOS driver A: is disk0

BIOS driver C: is disk2

BIOS 636kB/74512kB available memory

FreeBSD/i386 bootstrap loader, Revision 0.8

  (mailto:jkh@narf.osd.bsdi.com, Sat Apr 21 08:46:19 GMT 2001)

Loading /boot/defaults/loader.conf

/kernel text=0x24f1db data=0x3007ec+0x2062c -
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    <- For FreeBSD 5.1 and later: select “6” on “Welcome to

FreeBSD” screen.

    Hit [Enter] to boot immediately, or any other key for command

prompt.

    Booting [kernel] in 9 seconds…

    <-press SPACE key

    Type ’?’ for a list of commands, ’help’ for more detailed

help.

    ok load rr172x

    /modules/rr172x.ko text=0xf571 data=0x2c8+0x254

    ok autoboot

Note: If you have configured a RAID 10 using 4 disks, it will be registered to system

as device /dev/da0. You can use “/stand/sysinstall” to create partitions and

disklabels (like da0s1e) on da0. Then, create a new filesystem using “newfs /dev/

da0s1e”. Now you can mount /dev/da0s1e to somewhere to access it

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “load rr172x” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup.  To

configure the system to automatically install the module, type in the following

commands:

  # echo ’rr172x_load=”YES”’ >> /boot/defaults/loader.conf

This command will instruct the loader to load the RocketRAID 1720 module together

with the kernel.   After using this command, reboot the system.  The RocketRAID 1720

module should now automatically load each time the operating system starts up.

Note: When using FreeBSD 4.x, type in the following command to configure the

system:

# mknod  /dev/rr172x  c  200  0

Then, check to make sure the node “/dev/rr172x¡±, is present in the /dev directory.
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Step 4 Configure the System to Mount Volumes at Startup

Instruct the system to automatically mount the array by modifying the file /etc/fstab.

Example: Add the following line to instruct the system to mount /dev/da1s1e to

location /mnt/hpt after startup:

/dev/da1s1e       /mnt/hpt           ufs    rw   0    0

3 - Updating the Driver

To update the driver with a newer revision, simply reinstall the driver following the

steps discussed in the previous section, “Install the driver on an existing system”.

4 - Uninstalling the Driver

The driver can only be uninstalled when the system is not booting from devices

attached to the RocketRAID 1720 controller. To uninstall, remove the line

RR172x_load=”YES” located in /boot/defaults/loader.conf, and then delete the driver

module /modules/rr172x.ko or /boot/kernel/rr172x.ko.

FreeBSD Driver Support
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Customer Support

If you encounter any problems while utilizing the RocketRAID1720, or have any

questions about this or any other HighPoint product, feel free to contact our Cus-

tomer Support Department.

Troubleshooting Checklist

Before contacting our Customer Support department:

Make sure the latest BIOS, driver and RAID Software have been installed for the

RocketRAID1720.  Updates are available from our website.

Prepare a list of the computer system’s hardware and software (motherboard, CPU,

memory, other PCI devices/host adapters, operating system, applications)

 Contact Information

E-mail address: support@highpoint-tech.com

Phone: 408-240-6119 (request for support)

9:00AM-5:00PM, Pacific Standard Time

Additional information about HighPoint products is available from our web site:

http://www.highpoint-tech.com

Customer Support
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FCC Part 15 Class B Radio Frequency Interference statement

This equipment has been tested and found to comply with the limits for a Class B

digital device, pursuant to part 15 of the FCC Rules.  These limits are designed to

provide reasonable protection against harmful interference in a residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if not

installed and used in accordance with the instructions, may cause harmful interfer-

ence to radio communications.  However, there is no guarantee that interference will

not occur in a particular installation.  If this equipment does cause harmful interfer-

ence to radio or television reception, which can be determined by turning the equip-

ment off and on, the user is encouraged to try to correct the interference by one or

more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.

� Connect the equipment into an outlet on a circuit different from that to which the

receiver is connected.

� Consult the dealer or an experienced radio/TV technician for help.

Modifications not expressly approved by the manufacturer could void the user’s

authority to operate the equipment under FCC rules.

This device complies with part 15 of the FCC Rules.  Operation is subject to the

following two conditions: (1) this device may not cause harmful interference, and (2)

this device must accept any interference received, including interference that may

cause undesired operation.

European Union Compliance Statement

This Information Technologies Equipment has been tested and found to comply

with the following European directives:

� European Standard EN55022 (1998) Class B

� European Standard EN55024 (1998)


